Tutorials
for
E-MU Production Tools Software Bundle (PTSB-6)
© 2010 E-MU Systems
All Rights Reserved
Revision: A

E-MU World Headquarters
E-MU Systems
1500 Green Hills Road
Scotts Valley, CA 95066
USA

Europe
Creative Labs (Ireland) Ltd
Ballycoolin Business Park
Blanchardstown, Dublin 15
IRELAND

Japan
Creative Media K. K.
Kanda Eight Bldg., 3F
4-6-7 Soto-Kanda
Chiyoda-ku, Tokyo 101-0021
JAPAN
# TABLE OF CONTENTS

## Introduction .............................................................................. 5
- Before you Begin... ................................................................. 5
- IMPORTANT - Digital Audio System owners: .......................... 5

### Getting Started with Steinberg Cubase LE5 .......................... 6
1 - Setting up Cubase LE ............................................................. 6
   - Buffer Latency Setting .......................................................... 7
   - Setting up a New Project ......................................................... 7
   - Optional - Add Additional Input Busses ................................. 8
2 - Basic Multitrack Recording ................................................... 8
   - Add an Audio Track .............................................................. 8
   - Get Ready To Record ............................................................ 9
   - Record Another Track .......................................................... 10
3 - Recording a MIDI Track using the Proteus VX Sound Module ... 11
   - Make the Connections .......................................................... 11
   - Open VX & Load a Bank ......................................................... 12
   - To Record a MIDI Track ......................................................... 13
   - To Record a MIDI Track on another MIDI Channel ............... 13
   - Program Changes ............................................................... 13

### Getting Started with Cakewalk Sonar 8.5 LE ....................... 14
1 - Setting up Sonar LE ............................................................. 14
   - Run Sonar LE for the first time .............................................. 14
   - Set-up the Audio Options .................................................... 15
   - We're almost finished with the setup! .................................... 18
2 - Basic Multitrack Recording ................................................... 19
   - Record a Track ................................................................. 20
   - Create another Audio Track ............................................... 20
   - Record another Track ....................................................... 20
   - Save your Project ............................................................. 20
3 - Recording a MIDI Track using the Proteus VX Sound Module ... 21
   - Select the Virtual Instrument ................................................. 21
   - The MIDI Connection ........................................................ 22
   - Open Proteus VX ............................................................... 22
   - Load the Proteus X Composer Bank ..................................... 23
   - Play a Few Presets .............................................................. 23
   - To Record a MIDI Track ...................................................... 24
   - To Record a MIDI Track on another MIDI Channel ............ 24

### On Your Own .......................................................................... 26
Getting Started with Ableton Live Lite 8 .......................... 27
Before you Begin: ................................................................. 27
1 - Setting up the Preferences .............................................. 27
   Set up the Audio Parameters ............................................ 27
   Check the MIDI Parameters ............................................. 28
   Check the File Folder Parameters .................................... 28
2 - Follow the Live Lessons .................................................. 29
3 - Running the Proteus VX Sound Module from Ableton Live .......................... 30
   Load the Proteus X Composer Bank ................................. 31
   Change the Preset from Live ........................................... 32
4 - Record a MIDI Track in Live ............................................ 33
   Get Ready to Record ..................................................... 34
   Adjust the Loop Length ................................................ 34
   Add Another MIDI Track ............................................... 35
   Choose a Sound for MIDI Channel 2 ............................... 35
   Get Ready to Record on Channel 2 ................................. 35
   Saving your Work ......................................................... 36
Other Cool Tips ................................................................. 36
On Your Own ................................................................. 36

Technical Support ............................................................. 37

Internet References .......................................................... 37
   Forums ................................................................. 37


**TUTORIALS**

**Introduction**
This guide contains step-by-step tutorials of basic recording operations using your E-MU audio interface and four of the applications in the E-MU Production Tools Software Bundle (PTSB-6).

- **Cubase LE** - - - - 24-bit multi-track audio/MIDI sequencer for OS X/Windows
- **Sonar LE 8.5** - - - - 24-bit multi-track audio/MIDI sequencer for Windows
- **Ableton Live Lite 8** - an innovative composition and live performance tool for OS X and Windows
- **Proteus VX** - - - - a software sound module with 1000 sounds for Windows

We highly encourage you to install the software and follow along with the tutorials so that you can learn by doing. The first tutorial only takes about half an hour to complete, by which time you’ll know how to make multitrack recordings and much more.

**NEED MORE HELP?**
If you need additional help with the bundled applications, please see:

- **Windows**: Program Files\Creative Professional\[Your E-MU Product]\Documents\3rdParty.htm
- **OS X**: Applications Drive\Library\Documentation\[Your E-MU Product]\3rdParty.htm

**Before you Begin...**
- You should have already installed and tested your E-MU audio interface.
- You should hear the computer sounds coming out of the E-MU audio interface and your speakers when you play a CD or an MP3 using Windows Media Player or iTunes.

  If not, refer to the Quick Start Guide or pdf manual (located under Help in the PatchMix or USB Audio Control Panel application) to make sure that the drivers are correctly installed and that your audio interface is properly connected. If necessary, uninstall the E-MU Drivers, then reinstall following the instructions in the manual.

- You should have already installed Cubase LE5, Sonar 8.5 LE, and Ableton Live Lite 8 E-MU Edition software on your computer. Windows users should also have the Proteus VX software sound module installed.

- A source of audio should be connected to the inputs (a microphone, musical instrument, or CD/MP3 player).

**IMPORTANT - Digital Audio System owners:**
Select the **Product Default** session in PatchMix before launching any of the third party applications. This will ensure that ALL your available inputs appear in the audio applications and will avoid unnecessary confusion.

**To Select the Product Default Session:**
1. Select **New Session** from the PatchMix Mixer view.
2. Select **Product Default** from the list of available Templates and click **OK**.
3. Click **OK** again when the Session Settings dialog box appears.
4. Close the PatchMix DSP Mixer.

**TIP . . .**
Additional sound banks are available for the Proteus VX software sound module. Go to E-MU Sound Central at: [http://www.emu.com/shop/](http://www.emu.com/shop/)

**NOTE**
Proteus VX sound banks are loaded into system RAM. Some factory sound sets may be too large to fit into your available RAM.

Proteus X2, Emulator X2 and Emulator X3 have vastly expanded capabilities over Proteus VX and both stream samples from your hard disk requiring far less available RAM space.

**WARNING!**
Windows Users - After checking your audio, be sure to quit Windows Media Player.
Getting Started with Steinberg Cubase LE5
(Windows, OS X)
Steinberg Cubase LE5 is a 24-bit, multi-track audio/MIDI sequencer with high-quality effects, automation, virtual instruments (VSTi), and many other professional features.

The following step-by-step tutorials are designed to get you recording as quickly as possible.

1 - Setting up Cubase LE
Follow these instructions carefully to ensure that Cubase LE5 runs smoothly the first time. Cubase LE will remember these settings, so you’ll only have to do this once.

1. Open Cubase LE from the Start menu. An ASIO multimedia driver test dialog box will pop up to ask if you want to run the ASIO test. Choose No, because you won’t be using the driver anyway.

2. Select New Project from the File menu.

3. Select Empty and click OK.

4. A Select Directory pop-up dialog box will appear. Choose a location on your hard disk where you want to store your audio files, then click OK.

5. The Cubase LE Project window appears.

6. Select Device Setup… from the Devices menu.

7. Select VST Audio System from the left pane.

8. Select the ASIO Driver. Choose your E-MU interface from the list.

9. A pop up dialog box asks you if you want to keep or switch the ASIO driver. Select Switch.

TIP . . .
If you have two or more hard disks, it’s better to store audio files on a disk that isn’t running your OS.

WARNING!
DO NOT select the “ASIO Multimedia Driver” or the “ASIO DirectX Full Duplex Driver.”
Buffer Latency Setting

10. Click on the name of your E-MU interface that appears immediately below VST Audio System in the Devices pane. Refer to the following screen.

11. Click the Control Panel button. The pop-up dialog box shown at right appears.

12. Set the ASIO Buffer Latency as low as your computer will allow and click OK. (10ms is a good starting point.) A low latency setting is important to assure fast response when using virtual instruments and to minimize delay when monitoring through Cubase. If you hear crackles or other audio problems, try increasing the Buffer Size.

13. Close the Device Setup screen by clicking OK.

Setting up a New Project

14. Select Project Setup (Shift + S) from the Project menu. This is where you set the Sample Rate and Record Format (bit depth), among other things. Set the Record Format to 24 Bit and the Sample Rate to 44.100 kHz.

Note: We chose 44.1kHz because it is the most widely used. Feel free to use any sample rate you wish. When changing sample rates, always remember that all your software and hardware MUST be set to the same sample rate.

NOTE
E-MU 0202 Control Panel is shown at left. The Bit Depth field does not appear with products which use PatchMix.
Optional - Add Additional Input Busses
If you are using an E-MU audio interface that has more than two inputs, the following instructions will allow you to select these extra inputs to feed your audio tracks.

15. Select **VST Connections** (F4) from the **Devices** menu.

![](image1.png)

16. Select the **Inputs Tab**, revealing the window shown above.

17. Click the **Add Bus** button. The pop-up dialog box shown at right appears.

18. Select the number of mono or stereo input busses you want, then **click OK**.

19. Additional mono or stereo busses appear in the list. Note that the actual PatchMix input label appears in the Device Port field.

20. Close the window by clicking the close box. The inputs you added will now be available for selection in the Track Input field of the Inspector pane.

21. Now you’re ready to record. (Don’t worry, Cubase LE remembers all these settings.)

### 2 - Basic Multitrack Recording
This tutorial assumes you’re using a single input or a pair of inputs. For more advanced recording, refer to the Cubase LE manual.

**Add an Audio Track**

1. From the Cubase LE menu bar, select **Project, Add Track, Audio**. A pop-up dialog box appears, asking you if you would like to add a mono or stereo track. **Choose a mono track** for now. After making your selection, **click OK**. A new audio track is added to the project window.

![](image2.png)
2. The **Track Input Routing** field is where you connect your audio inputs to the track. “Left-Stereo In” will appear in the Track Input field. You can change this to “Right-Stereo In” if you want to use the right input. *(Click and hold the mouse over the label.)*

- If you added extra VST Connections (Step 17 on the previous page), you’ll be able to choose additional inputs.

3. Make sure the Monitor button is **OFF**. You will be direct monitoring the input through your E-MU Interface. The **Product Default** session in PatchMix is already set up for hardware monitoring.

   **Important:** If you use hardware Direct Monitoring, you will not be able to hear VST effects inserted on the track. If you wish to monitor your VST effects while recording, turn Off Direct Monitoring and use software monitoring.

4. If you own an E-MU USB interface, press the Direct Monitor button. If you are recording a mono track, set Direct Monitor to **Mono** by pressing the Direct Monitor button again.

**Get Ready To Record**

5. Plug in your instrument or microphone. Press the Monitor button, turning software monitoring **On**. You should see activity on the Track Meter (see above) when feeding a signal into the input. This step verifies that you are routing the correct input to your track. If you don’t see meter activity, check your input routing.

6. **Press the Monitor button again**, turning software monitoring **Off**.

7. **Optional Step - Metronome:** To toggle the Metronome on and off, press C on the computer keyboard. To adjust the metronome output level, press the transport **Play** control, then select **Metronome Setup**... from the Transport menu. Use the volume slider to set the desired metronome level.

8. Press the **Go to Previous Marker / Zero** button.

9. Make sure the **Record Enable** button on the track is on (it should be on by default).
10. Press the **Record** button on the Cubase transport control panel. The button turns red and you’re recording.

11. When you’re finished recording your track, press the **Spacebar**, or press the **Stop** button on the Cubase Transport Control.

12. Press the **Go to Zero** button.

13. Press the **Spacebar** or press the **Play** button to play back your new Track.

**Record Another Track**

14. Press the **Go to Zero** button.

15. Drag the audio chunk you just recorded down below itself and release the mouse button. A new track is automatically created with your recording. This is a quick and easy way to set up a new track in Cubase. Now you’re all set to record again on Track 1.

16. Press the **Record** button on the Cubase transport control panel and you’re recording again. You’ll hear your first track playing along with you.

17. **Repeat steps 12-14** to record more audio tracks.

18. Press the **Mute** button to silence any tracks you don’t want to hear.
3 - Recording a MIDI Track using the Proteus VX Sound Module
(Windows only)

You’ll need a MIDI interface and a MIDI keyboard (or other MIDI input device) for this tutorial. Please refer to the Proteus VX manual for the complete set of instructions (located under the Help menu item).

Make the Connections

1. Connect the MIDI out of your MIDI keyboard to the MIDI input of your MIDI interface.

2. From the Project menu, select Add Track, Instrument.

3. A pop-up dialog box appears asking you to select a VST Instrument. Select Proteus VX. Select a Count of 1. Click OK.

After a short delay, the Cubase Project Window should now look more or less like the one below with one or more Audio tracks and one Instrument track:

**NOTE**
Proteus VX can also run as a standalone application.

**NOTE**
Selecting a Count of 2 or more, instantiates multiple copies of Proteus VX, which results in very inefficient usage of your CPU. (See the note on page 13.)

**NOTE #2**
If you have Proteus X or Emulator X, you can select these in place of Proteus VX.
Open VX & Load a Bank

4. Since Proteus VX uses samples as the basis of its sound, you need to load a bank of samples before it can be played. The Edit Instrument button, located in the Inspector section of the window, allows you to edit the virtual instrument.

5. Click the Edit Instrument button. The Proteus VX main window appears.

6. Now we can load the Proteus X Composer bank. **Select Proteus X Composer** from the Proteus VX File menu. The bank is installed here: "Program Files\Creative Professional\E-MU Sound Central\Proteus X Composer." The bank might also be listed at the bottom of the file menu pulldown. Loading may take a little while.

7. **Change the Preset using the Inc/Dec keys.** You also have to select a preset before you can hear anything. There are 1024 different presets (sounds) in this huge bank.

8. Bring up the **mini keyboard** by clicking the icon on Proteus VX and play a few notes. You should be hearing sound.

   **TIP . . .**
   Increase the headroom setting (more positive) to increase the volume and decrease the amount of available headroom.

   - If the sound volume is very low, you can decrease the Headroom of Proteus VX. (Options, Preferences, Headroom/Boost) Keep in mind that with less headroom, the Proteus VX will be more prone to clipping when multiple channels are played.

9. **Play your MIDI controller** and verify that it plays Proteus VX. If not, check to make sure your MIDI keyboard is set to the same MIDI channel number as Proteus VX (probably channel 1).

10. Try out the MIDI Controller knobs on your MIDI keyboard. In order for these to work, the continuous controller numbers of your keyboard knobs must match those on Proteus VX. (Options, Preferences, Controllers tab).
11. Feel free to play around for awhile and don’t worry about losing anything. Nothing is made permanent until you Save the bank, so have fun.

To Record a MIDI Track

12. Make sure the Record Enable button on the MIDI track is on (it should be on by default).

TIP . . .
To quickly browse through the presets, place the cursor in the preset number and use the up/down arrow keys on your computer keyboard to select presets.

13. Click Record on the Cubase LE Transport control and start playing your MIDI controller.

14. Press Stop when you’re finished recording the first track.

15. Press the Go To Start button, ⇩

16. Press Play > on the Cubase Transport to play back your track.

To Record a MIDI Track on another MIDI Channel

NOTE: Proteus VX VSTi can play back up to 16 MIDI tracks at once, however, the LE version of Cubase 5 only supports a single MIDI channel per VSTi. You could load another instance of the Proteus VX for each additional channel, but this is a very inefficient usage of your CPU resources and is NOT recommended. The full version of Cubase 5/Nuendo 5 does support multiple MIDI channels on a single VSTi.

Program Changes
Cubase LE allows you to insert MIDI Program Change messages in the MIDI sequence. (Key Editor, List Editor, Insert Program Change) This trick makes it possible to use more than one Proteus VX preset in a song.

Save As / Save As Template
Now might be a good time to save your project so you can come back to it later. Simply select Save As . . . from the File menu and choose a location for the project.

Cubase LE also allows you to save the project as a Template. You are offered to load your saved Templates when you select a New Project from the File menu.

On Your Own
This tutorial only covers the basics of recording tracks with Cubase LE and Proteus VX. From here we recommend you make use of the excellent documentation included with Proteus VX and Cubase LE, which can be found in their Help menus. The internet is also a vast source of information about the included software and digital audio recording in general. We have provided a few relevant links on the last page of this document. Good luck and have fun!
Getting Started with Cakewalk Sonar 8.5 LE

Sonar LE 8.5 is a 24-bit multi-track audio/MIDI sequencer with high-quality effects, automation, virtual instruments (VSTi/DXi), and many other professional features.

The following step-by-step tutorials are designed to get you recording using Sonar 8.5 LE. After you finish the tutorial we encourage you to read the Sonar 8.5 LE pdf manual in order to learn about the many features of this comprehensive program.

1 - Setting up Sonar LE

Follow these instructions carefully to ensure that Sonar LE runs smoothly the first time. Sonar LE will remember these settings, so you’ll only have to do this once.

Run Sonar LE for the first time

1. After installation Sonar LE will automatically open. After completing the product registration, the following dialog box appears:

2. Click the Yes button to allow the Wave Profiler to analyze your audio system.

3. When the Wave Profiler has finished, Sonar LE opens and the following dialog box appears.

4. Click Close to close the dialog box. The Sonar Project Window appears.
Set-up the Audio Options

5. From the Options menu, select Audio. The dialog box shown below appears.

![Audio Options dialog box]

6. Make sure that the Audio Driver Bit Depth is set to 24.
7. Click on the Advanced tab to access the next window.

![Advanced Audio Options]

8. Select ASIO as the Driver Mode, then click Apply.
9. Click the **Drivers** tab.

10. Make sure that all inputs and outputs corresponding to your E-MU interface are checked. This setting determines which inputs and outputs are available in the Track View of Sonar.

11. Click on the **General** tab. Note that the Mixing Latency options have now changed because you selected ASIO drivers.

12. Click on the **ASIO Panel** button. The ASIO latency dialog box appears.
13. Set the **Buffer Size** somewhere between 4 and 12 ms (milliseconds). The exact setting depends on the speed of your computer. A low latency setting is important to assure fast response when using virtual instruments and to minimize delay when monitoring through Sonar. If the buffer size is too large, sluggish performance will result. On the other hand, if the buffer size is too small, gaps in the audio and stuttering will most likely result. If you hear crackles or other audio problems, try slightly increasing the Buffer Size. You may have to experiment to find the optimal setting for your computer. As you add more audio tracks, plug-ins and other processes, you may need to increase the Buffer Latency setting.

14. Set the **Bit Depth** to 32-bit and check “Per Application Preferences.”

15. Close the **Audio Options** screen by clicking **OK**.

**Note:** If the Sonar LE application crashes for any reason, it is recommended that you re-boot the computer.

16. Now select **Global** from the **Options** menu.

17. Select the **Audio Data** tab as shown below.

18. Set the **Record Bit Depth** to 24 bits to use the best possible resolution.

19. Set the **Global Audio Folder** location where your huge audio files will be kept.

20. Click **OK** to dismiss the Global Options.

**TIP . . .**
If you have two or more hard disks, it’s better to store audio files on a disk that isn’t running your OS.
Getting Started with Cakewalk Sonar 8.5 LE
1 - Setting up Sonar LE

We're almost finished with the setup!

21. If you have a MIDI interface or USB keyboard connected (such as the E-MU X midi 2x2, Xboard, or a Digital Audio System), select **MIDI Devices** from the **Options** menu.

22. **Select the MIDI ports** you wish to use. In the example shown, we are using the two ports from the E-MU 1616 and two more ports on an E-MU XMIDI 2 x 2.

![MIDI Devices window](image)

23. A MIDI interface and/or MIDI keyboard is necessary to use the included Proteus VX sound module and other virtual instruments. Shameless Plug: If you don’t have a keyboard, may we recommend the E-MU LONGboard or SHORTboard. These are quality musical instruments with a built-in MIDI interface. If you have a MIDI keyboard, but need a MIDI interface, the E-MU XMIDI 1x1 or XMIDI 2x2 will fill your need admirably. Go to [www.emu.com](http://www.emu.com) to see what we have to offer.

24. **Close Sonar LE** completely and restart the application. This is always a good idea after changing audio settings. Now you’re ready to begin the tutorial.
2 - Basic Multitrack Recording

This tutorial assumes you’re using a single input or pair of inputs. Sonar opens with 1 audio track and 1 MIDI track by default.

The Sonar Project Window

1. Track 1 is an audio track. Locate the input and output routing fields in the Track Pane as shown at right.

2. Select the input source by clicking on the small triangle on the input field. Select the desired input from the list.

3. The Input Echo button should be OFF. You will be direct monitoring the input through your E-MU Interface.

4. If you are using an E-MU USB interface, press the Direct Monitor button. If you are recording a mono track, set Direct Monitor to Mono by pressing the Direct Monitor button again.

TIP . . .
You may have to Maximize the track in order to see the Input and Output routing fields.
5. Press the Track Record Enable button \( \text{\scriptsize R} \) for the track (see the diagram below). The track turns a dull red color to indicate that it is record-enabled. You should now see activity on the Track Input Meter when feeding a signal.

6. Adjust the input level so that the meter comes near -6dB without ever going into the red.

**Record a Track**

7. Press \textit{Record} on the Sonar LE Transport control and start playing.

8. Press \textit{Stop} when you’re finished recording the first track.

9. Press \textit{Play} on the Sonar LE Transport to play back your track.

10. If you want to dump the track and start over, \textit{click over the waveform display in the track and press Delete} on your computer keyboard.

**Create another Audio Track**

11. From the \textit{Insert Menu}, select \textit{Audio Track}. Track 3 appears in the Project window.

**Record another Track**

12. \textit{Select Track 3} and click the \textit{Restore Strip Size} button \( \text{\scriptsize R} \) to expose the input and output routing.

13. \textit{Set the Input source} for the track. Click on the little triangle \( \text{\scriptsize \downarrow} \) on the right side of the track Input box.

14. Disable record for Track 1 by clicking on the \textit{Track Record} button \( \text{\scriptsize R} \). Off.

15. Enable recording for Track 3 by clicking on the \textit{Track Record} button \( \text{\scriptsize R} \) On.

16. Press the transport \textit{Record} button and you’re recording.

**Hot Tip:** A quick way to record additional tracks using the same input is to simply drag the Part (audio region) you just recorded up or down to another audio track in the Sonar Project Window, then just hit \textit{Record} again and go. (Choose \textit{Blend Old and New} if asked in the Drag & Drop Options.)

**Save your Project**

17. Choose \textit{Save As…} from the Sonar LE \textit{File} menu to save your project. Choose a name and location that will make the project easy to find later.

\textit{TIP} . . .

If you don’t see meter activity on the track after enabling Record, check the Input for the track. Make sure you are selecting the proper input source.

\textit{TIP} . . .

You can also create a new track by selecting Clone, from the Track menu. This handy feature duplicates the currently selected track complete with input/output routings.
3 - Recording a MIDI Track using the Proteus VX Sound Module

These instructions explain how to start Proteus VX from within Sonar LE. You’ll need a MIDI interface and a MIDI keyboard (or other MIDI input device) for this tutorial. Please refer to the Proteus VX manual for the complete set of instructions (located under the Help menu item).

1. Connect the MIDI output of your MIDI keyboard to the MIDI input of your MIDI interface.

Select the Virtual Instrument

2. From the Insert menu, select Soft Synths, E-MU, ProteusVX from the View menu.

3. The following pop-up dialog box appears.

4. Select the options (MIDI Source, Synth Track Folder, First Synth Audio Output) as shown. Click OK to continue. (You may have to wait a few seconds.) Proteus VX is added to the synth rack and two new tracks have been added to the track list.

New Proteus VX Tracks

Audio output from Proteus VX
MIDI input to Proteus VX

Restore Strip Size
Click here to view the MIDI strip controls.

NOTE
Proteus VX can also run as a stand-alone application.
The MIDI Connection

5. **Make sure that your MIDI Interface is selected** as the MIDI input in **Omni** mode by clicking on the “Restore Strip Size” box on the new MIDI track that was created.

![Select your MIDI interface]

- **Note:** “Omni” mode allows Proteus VX VSTi to receive on all 16 MIDI channels from your MIDI keyboard. (Proteus VX VSTi is “multi-timbral” and can assign a different preset to each of the 16 MIDI channels.)

**TIP . . .**
Check the Sonar MIDI Monitor in the SysTray to verify that you’re receiving MIDI.

Open Proteus VX

6. Double-click on the **keyboard icon** in the Synth Rack located at the bottom of the track window to open the Proteus VX editor.

![Double-Click Here to Open Proteus VX]

7. You can also click on the keyboard icon in the synth track itself.

![Double-Click Here to Open Proteus VX]

8. After a few seconds, the Proteus VX editor screen appears.
Load the Proteus X Composer Bank

Before you can play Proteus VX, you have to load a bank of sounds. (This information will be saved when you save your Sonar LE Project.)

9. **Open the Proteus X Composer bank.** Select **Proteus X Composer** from the **Proteus VX File menu**. The bank is installed by default: “Program Files/Creative Professional\E-MU Sound Central\Proteus X Composer.” Loading takes a few seconds.

10. **Change the Preset using the Inc/Dec keys.** This bank contains 1024 different presets (or sounds).

11. Bring up the **mini keyboard** by clicking the icon on Proteus VX and play a few notes. You should be hearing sound.

   - **Note:** If the sound volume is very low, you can decrease the Headroom of Proteus VX. (Options, Preferences, Headroom/Boost) Keep in mind that with less headroom, Proteus VX will be more prone to clipping when multiple channels are played. Watch the output meters on Proteus VX!

12. **Play your MIDI controller** and verify that it plays Proteus VX. If not, make sure that your MIDI keyboard is set to the same MIDI channel number as Proteus VX (probably channel 1). You can also change the MIDI channel of Proteus VX using the channel Inc/Dec keys shown on the previous page.

**Play a Few Presets**

13. **To Audition Presets:** first highlight the preset number (i.e. 0000), then scroll through the presets using the up/down keys on your computer keyboard.

14. Try out the MIDI Controller knobs on your MIDI keyboard.

   In order to work, the continuous controller numbers of your keyboard knobs must match those on Proteus VX. *(Refer to the manual that came with your MIDI keyboard, or change the controller numbers on Proteus VX, located under Options, Preferences, Controllers tab.)*

15. Select the 16 channel tab. This page allows you to select presets for all 16 MIDI channels.

16. Select a preset for MIDI Channel 1 by clicking the little triangle.
Getting Started with Cakewalk Sonar 8.5 LE
3 - Recording a MIDI Track using the Proteus VX Sound Module

WARNING!
Loading another instance of the Proteus VX for each channel is a very inefficient usage of your CPU resources and is NOT recommended.

NOTE
You can also select a single preset for the track by selecting the Program Change number you want (Insert, Bank/Patch Change).

To Record a MIDI Track

17. Minimize the Proteus VX window by pressing the minimize button on Proteus VX.
18. Maximize the Proteus VX MIDI track by pressing the Maximize button.

19. The Track Pane expands to show all the track options, as shown at right. Set the Channel field (CH) to Omni. (This allows MIDI data on ANY incoming MIDI channel to be recorded.)

20. Restore the Strip to its normal size by clicking the “Restore Strip Size” button.

21. Record-Enable the MIDI Track by pressing the red Record button. The clips pane section of the track turns a dull red color to indicate that it is record-enabled.
   • IMPORTANT: Be sure to turn Track Record Enable OFF for any tracks you don’t want to record on, such as previously recorded tracks.

22. Set your MIDI keyboard to transmit on MIDI Channel 1 and verify that you hear the Proteus VX playing as you play your MIDI keyboard.

23. Press Record on the Sonar LE Transport control and start playing.

24. Press Stop (or hit the Spacebar) when you’re finished recording the first track.

25. Press Play on the Sonar LE Transport to play back your track.

To Record a MIDI Track on another MIDI Channel

Proteus VX VSTi can play back up to 16 MIDI tracks at once with a different preset on each channel. Using several channels on one VSTi uses far fewer CPU resources than using multiple VSTi’s with one channel each.

26. Right-click anywhere in the Track Pane below the previous MIDI track. A pop-up menu appears. Select Insert MIDI Track.
27. **Maximize** the Proteus VX MIDI track by pressing the Maximize button.

28. Make sure **Omni** is selected as the MIDI input (see below).

29. Make sure **Proteus VX** is selected as the **Output**.

30. Record Disable the previous MIDI track by clicking the **Track Record Enable** button.

31. Record Enable your new MIDI track by clicking its **Track Record Enable** button.

32. Restore the Proteus VX editor by **double-clicking on the little keyboard icon** in the Proteus VX track.

33. Select a preset for channel 2 by **clicking the little triangle on channel 2** in the 1-16 channel view of Proteus VX.

34. **Set your MIDI keyboard to transmit on MIDI Channel 2** and verify that you hear the Proteus VX playing as you play your MIDI keyboard.

35. **Play your MIDI keyboard** to listen to the presets during the selection process.

36. Click **OK** when you’ve made your selection.

37. **Minimize or close Proteus VX** when you’ve made your preset selection.

38. Press **Record** on the Sonar LE Transport control and start playing.
39. Press **Stop** when you’re finished recording the second track.

40. Feel free to record additional MIDI tracks. You have 16 MIDI channels.

41. To mix your Proteus VX MIDI tracks, use MIDI Controller 7 (Volume) transmitted by your MIDI keyboard. The MIDI controllers can be recorded by Sonar to create an automated mix.

**TIP . . .**

The Export Multisample feature of Proteus VX allows you to save a bank containing ONLY the presets and samples used in the Multisetup. This gives you a smaller Project and a MUCH shorter load time.

**On Your Own**

Now that you’ve had a little taste of what Sonar LE and Proteus VX can do, please read the Proteus VX Operation Manual pdf (*located under the Help menu*) to learn all about this exceptional instrument. Sonar LE also includes useful online documentation and help files to help you learn about the many other features of this powerful program.
Getting Started with Ableton Live Lite 8
(Windows/OS X)

This guide contains a basic walk-through of Ableton Live Lite 8 (E-MU Edition) to get you recording and playing back audio. The guide also discusses configuring Live Lite 8 to use VST instruments, such as Proteus VX for Windows. We encourage you to perform the steps on your computer as you read so that you can “learn by doing.”

Live Lite 8 is an innovative composition and performance tool. Live combines digital recording, virtual instruments, and digital effects with an original interface design that many people find more intuitive than traditional designs.

The following step by step tutorials are designed to get you recording as quickly as possible. After you’ve finished the tutorial we encourage you to follow all of Live’s excellent interactive lessons and read the Live Reference Manual pdf in order to learn more about the application.

Before you Begin:

• You should have already installed the E-MU software on your computer according to the instructions in your “Getting Started” manual.
• You should have already installed the Live Lite 8 software on your computer and unlocked it according to the instructions provided with the Ableton Live User Manual.
• You should hear sounds from Live Lite 8 when you play the demos.
• PC Users - You should have already installed the Proteus VX software.
• You should have your MIDI interface and keyboard connected if you want to record MIDI.

1 - Setting up the Preferences

Unlock Live Lite 8, E-MU Edition by following the instructions in the Preferences menu. (Windows - Options menu, Preferences; OS X - Live menu, Preferences) Read the following instructions to configure the Audio and MIDI preferences. Live will remember these settings, so you’ll only have to do this once.

Set up the Audio Parameters

1. Click the Audio tab of the Preferences dialog box. The Audio Setup page appears.

NOTE
The first time you run Live, you may get the message, “Audio is disabled. Please choose an audio output device from the Audio Preferences.”

Simply follow the instructions in “1 - Setting up the Preferences” to correct the situation.

WARNING!
DO NOT select the “ASIO Multimedia Driver” or the “ASIO Direct X Full Duplex Driver.”
2. Select ASIO as the Driver Type. Select [your E-MU Interface] as the Audio Device.

Check the MIDI Parameters

3. Click the MIDI/Sync tab of the Preferences dialog box. The MIDI Setup page appears. (Live enables every MIDI input by default.)

Windows

4. Your MIDI interface or USB MIDI keyboard should appear in the list. Make sure it’s selected.

Check the File Folder Parameters

If you have trouble browsing Audio Units or VST Plug-Ins, you may need to manually locate them. Follow the steps below. If you have problems, please refer to the Live pdf manual, located under “Help”.

5. Click the File Folder tab of the Preferences dialog box. The File Folder page appears.
6. **PC Users:** Make sure that “Use VST Plug-In Custom Folder” is selected as shown below. The default location for Proteus VX VSTi is: "C:\\Program Files\\Steinberg\\VstPlugIns\". If not already selected, browse to this folder unless you’re certain that your VST Plug-Ins are stored in another location.

7. **OS X Users:** Turn “Use Audio Units On,” and browse to the location where your Audio Units (if any) are stored.

8. Close the Preferences dialog box. Now you’re ready to begin composing with Live.

### 2 - Follow the Live Lessons

Ableton Live contains built-in tutorials to help you learn your way around. If you don’t see the Lessons pane on the right side of the window, simply select Lessons from the View menu.

You should go through the following lessons before continuing:

- **Recording Audio**, explains the basics of recording.
- **Playing Software Instruments**, is highly recommended since it provides a good background for using Proteus VX VSTi in Live Lite 8.

After finishing these lessons, feel free to continue on with the rest of the lessons if you so desire. When you’re ready to add Proteus VX to the mix, read on.
3 - Running the Proteus VX Sound Module from Ableton Live

30 E-MU Production Tools Software Bundle

NOTE
These instructions also apply to Proteus X or Emulator X.

NOTE
Please refer to the Proteus VX manual for the complete set of instructions (located under the Help menu item).

Proteus VX can also run as a stand-alone application.

3 - Running the Proteus VX Sound Module from Ableton Live
(Windows only)

These instructions explain how to run Proteus VX from within Live Lite 8. Proteus VX adds a professional-quality sample player and over 1000 new sounds and integrates perfectly with Ableton Live Lite 8. In this tutorial, you’ll learn how to use a MIDI keyboard and the pre-recorded MIDI loops that come with Live Lite 8 to play Proteus VX.

• In preparation for this tutorial, select the third Live lesson - Improvising With Loops. If you haven’t already done so, go through the Lesson at least once until you are familiar with the concept of loops in Ableton Live.

1. Load the Live Set associated with the A Tour of Live lesson by clicking the button shown below. The Tour of Live Demo appears.

2. Press the Session View button. The window should look like the one shown below.

3. From the Plug-in Device Browser, select Proteus VX from the E-MU folder.

4. Click and drag the Proteus VX VST icon over the Clip/Device Drop Area as shown above. Wait a few seconds.

5. The Proteus VX editor window appears. (See the image on the following page.)
Load the Proteus X Composer Bank

6. Open Proteus X Composer from the Proteus VX File menu. The bank is installed here by default: “Program Files\Creative Professional\E-MU Sound Central\Proteus X Composer.” This is a huge bank and loading takes a few seconds.

7. Make sure Proteus VX is set to MIDI Channel 1 as shown above.

8. Using the preset increment/decrement keys, select a preset such as “Dynamic Grand,” shown above.

9. Play your MIDI or USB keyboard. You should be hearing music. If not, check to make sure your keyboard is set to MIDI channel 1. You should also see activity on the MIDI From indicator as you play. If not, check your connections. If you see MIDI activity but still don’t hear anything, make sure the Arm Track Record button is On (red).

10. Using the preset increment/decrement keys, check out a few more sounds. You have 1023 to choose from!

11. Pick a sound you like, then close the Proteus VX editor by clicking the close box. This only hides the editor screen and doesn’t close Proteus VSTi.

12. Notice that you now have a new MIDI Track and that the Proteus VX Instrument now appears at the bottom of the window.

13. Select File Browser 1, open the Clips folder and open the Rhythmic or Keys folder.
14. From the Keys folder, **drag and drop** one of the clips over to the **Clip area** on your Proteus VX MIDI track as shown.

15. Press the **Master Scene Launch** button for the Verse scene A.

16. Drag and drop a few more clips over to the track and try them out.

---

**NOTE**

Proteus VX sounds are called Presets or Programs. Ableton Live Programs are offset by +1 from Proteus VX.

---

17. When you have a clip you like, click the **Clip Overview Hot Spot** or simply double-click on the clip. (**Hint**: Shift+Tab toggles the view.)

---

The Clip View appears at the bottom of the application window.

---

18. Click on the **Show/Hide Notes Box** to reveal the notes box as shown above.

---

**TIP . . .**

Set the Sub-Bank number to access presets above 128. Sub-Bank 2, Program 1 = Preset 128 on Proteus VX.

---

19. Click on the **Program Select** field in the Notes box. A black border appears around the Program field showing that it has the “focus”. Select any preset number from the pop-up list.

---

20. Use the **Up/Down Arrow** keys on your computer keyboard to increment or decrement through the presets. You can even do this while the clips are playing to try out sounds in a hurry.

---

21. Assign different Program Change numbers to different clips and notice that they are remembered by Live.
4 - Record a MIDI Track in Live

Proteus VX is a multi-timbral instrument with the ability to play 16 different sounds at once. Let’s get ready to make a multitrack MIDI recording.

1. Click the **Track View Selector** at the bottom of the window or simply double-click on the clip to show the Proteus VX Device. (Shift+Tab toggles the view.)

The Proteus VX Device appears as shown below.

2. Click on the Tool icon  to bring up the Proteus VX editor.

3. Click the **1-16 tab** to view the preset selections 16 MIDI channels. When multitrack recording it’s often easier to give each track its own MIDI channel and preset.

4. Click the little triangle to the right of the preset selection field for **Channel 1**. The preset selection dialog box appears.

5. Hit the **Spacebar** to start Live, then **browse though the presets**. Click **OK** when you find one you want to use for recording.

6. Close the Proteus VX editor by clicking the close box.
7. Open the Preferences via the Options menu (PC) or Live menu (OS X) and choose the **Record/Warp/Launch** tab. Set the Count-in to any value other than “None.” Live doesn’t start recording until the count-in period has elapsed and gives you time to get ready after pressing “Record.” Close the Window.

8. **Delete all the Clips** in your MIDI track. (Select a clip and hit backspace to delete it.)
   - If your MIDI interface isn’t already connected, you’ll have to quit Ableton Live Lite 8, connect the MIDI interface, then restart Ableton Live Lite 8 before continuing.

9. Set up the MIDI track as shown at left.
   a. Select your MIDI Interface in the “MIDI From” field.
   b. Monitor should be set to Auto.
   c. Set the Audio To = Master.
   d. Turn Arm Session Record On (red).

10. **Play the keyboard.** You should hear Proteus VX playing the last sound you selected on channel 1. Go ahead and change the sound if you wish. (Double-click the top of the Track, then click the **Wrench** icon on the Device Title Bar. Make sure you’re changing the sound on channel 1.)

Get Ready to Record

11. Start up the **Verse** using the **Scene Launch button** and practice playing along with it.

12. **Optional:** You can set the **Global Quantization** value to correct the timing of your playing. Set it to anything other than “None”.

13. Click one of the round **MIDI Clip Record** buttons to begin recording. Recording will begin after the Count-In period you specified.

14. Click the **Spacebar** to stop recording.

Adjust the Loop Length

15. Start up the Verse using the Scene Launch button and take a listen. You’ll notice that your part doesn’t line up with the others after the first play through. This is because your loop length is not a multiple of four bars. Let’s fix that.

16. Click on the clip you just recorded and your clip will appear at the bottom of the window. It might look something like the one below.
17. Click and drag the Loop End triangle so that it lines up with the number 5. Now the loop is exactly 4 bars long and will sync with the rest of the song. You can also adjust your part by dragging the bars in the note editor.

18. Start up the Verse again using the Scene Launch button. Now it should play in perfect sync.

19. For fun, try changing the Program Number. Remember how? Click the Show/Hide Notes icon, give Program the focus, then change the Program number while the scene is playing using the up/down keys.

20. When you’re happy with the recording, disarm recording for the track by clicking the arm button, turning it grey.

Add Another MIDI Track

21. From the Create menu, select Insert MIDI Track (PC: Ctrl+Shift+T; OS X: ⌘ T). A new MIDI track appears.

22. On the new MIDI Track, the MIDI To box reads “No Output.” Instead, select 6-ProteusVX. This links the new MIDI track to the MIDI track containing Proteus VX.

23. Now click on the box that reads “Track In” to see the list of MIDI channels. Select 2-ProteusVX as shown at right.

24. Turn Arm Session Record On for the MIDI track.

Choose a Sound for MIDI Channel 2

25. Double-click on the 6 ProteusVX heading to show the Proteus VX VSTi. Next, click on the wrench icon again to open Proteus VX.

26. Select a Preset on Channel 2. Click the little triangle to the right of the preset selection field for Channel 2.

- Note: There are several ways to select presets. See the Proteus VX Operation manual pdf for details.

27. You should now be hearing the preset you selected on channel 2 when you play your MIDI keyboard.

Get Ready to Record on Channel 2

28. Start up the Verse using the Scene Launch button and practice playing along with it.
29. Click one of the round MIDI Clip Record buttons to begin recording. Recording will begin after the Count-In period you specified.

30. Click the Spacebar to stop recording.

Saving your Work

31. Save your work by selecting Save Live Set As... from the File menu. The next time you load the set, the Proteus VX bank will automatically load as well.

Other Cool Tips

- **To control Proteus VX with the knobs on your MIDI keyboard:**
  Go to the MIDI Preferences on Proteus VX (Options, Preferences, Controllers tab) and make sure the MIDI Continuous Controller numbers match the ones your keyboard is sending. You can change the controller numbers on either your MIDI keyboard or Proteus VX, just as long as they both match.

- **To control Proteus VX with the Assignable X/Y Controls in Live:**
  1. Click the Unfold Device Parameter triangle to reveal the Configure button.
  2. Click the Configure button and move any of the MIDI Controller knobs on ProteusVX to select them. The controllers you selected are now added to Live’s X-Y Controller panel.

3. Select any two of the MIDI Controllers you selected to assign them to the X and Y axis of Live. Move the green ball to control two parameters at once.

TIP . . .
For more information about MIDI controllers please refer to the Proteus VX pdf manual.

On Your Own

Now you’ve had a little taste of what Proteus VX and Ableton Live Lite 8 can do. But don’t stop now! Read the Proteus VX Operation Manual pdf (located in the ProteusVX Help menu) to learn all about this exceptional instrument.

Ableton Live Lite 8 includes several excellent hands-on tutorials to help you learn all the features of this ground-breaking musical application. It’s easy and fun, so check it out!
**Technical Support**

If you need technical support on any of the bundled Production Tools software, please contact the respective manufacturer.

- Cubase LE 5 ........................................... [http://www.steinberg.net/en/support.html](http://www.steinberg.net/en/support.html)
- Live Lite 8 .......................................... [http://www.ableton.com/support](http://www.ableton.com/support)
- Peak Express ....................................... [http://www.bias-inc.com/support](http://www.bias-inc.com/support)
- Amplitube X-Gear .................................. [http://www.ikmultimedia.com](http://www.ikmultimedia.com)

**Internet References**

**MIDI & Digital Recording**

- Software Updates, Tips & Tutorials .. [http://www.emu.com/support](http://www.emu.com/support)
- Setting up a PC for Digital Audio ..... [http://www.musicxp.net](http://www.musicxp.net)
- MIDI Basics ........................................ Search for "MIDI Basics" (many sites)

**Forums**

- Studio Central Forum ....................... [http://www.tweakheadz.com](http://www.tweakheadz.com)
- Sound Card Benchmarking .............. [http://audio.rightmark.org](http://audio.rightmark.org)
- Driver Heaven Forum ....................... [http://www.driverheaven.net](http://www.driverheaven.net)
## INDEX

### A
- Ableton Live Lite 8 for E-MU running Proteus VX in 30
- setting up 27
- tutorial 27
- Add Input Busses, to Cubase LE 8
- Add Track, Cubase LE 11
- ASIO Buffer Latency 7
- Assignable X/Y Controls, Live 36

### B
- Bit Depth 7
  - setting in Cubase LE 7
- Buffer Latency Setting
  - Cubase LE 7
  - Sonar LE 17

### C
- Clip Overview Hot Spot 32
- Clipping, Proteus VX 12, 23
- Continuous Controller Numbers 36
- Control Panel, E-MU 7
- Controller Knobs, MIDI keyboard 12, 23, 36
- Cubase LE
  - project window 6
  - setting up 6
  - tutorial 6

### D
- Devices Menu, Cubase LE 6
- Direct Monitor
  - Cubase LE 9
  - Sonar LE 19

### E
- E-MU ASIO, Sonar LE 15
- Export Multisample, Proteus VX 26

### F
- Forums, online 37

### H
- Headroom, Proteus VX 12

### I
- Input Echo Button, Sonar LE 19
- Input Source & Signal Level
  - Cubase LE 9
  - Sonar LE 20
- Inputs, adding to Cubase LE 8
- Insert MIDI Track, Ableton Live 35
- Internet References 37

### L
- Loop Length, Ableton Live 34

### M
- Metronome
  - Cubase LE 9
- MIDI
  - channels, using multiple 24, 35
  - continuous controller numbers 36
  - program change, Cubase LE 13
- MIDI Connection
  - Ableton Live 28
  - Cubase LE 11
  - Sonar LE 22
- MIDI Track
  - recording in Ableton Live 33
  - recording in Cubase LE 13
  - recording in Sonar LE 24
- Mini Keyboard 12, 23
- Monitor Button, Cubase LE 9
- Multitrack Recording
  - Cubase LE 8
  - Sonar LE 19

### O
- Options Menu, Sonar LE 15

### P
- PatchMix Setup 5
- Preferences, Ableton Live 27
- Product Default session 5
- Program Change
  - Ableton Live 32
  - Cubase LE 13
  - Sonar LE 24
- Project Window, Cubase LE 6
Index

Proteus VX
editor screen 22
using with Ableton Live 30
using with Cubase LE 11
using with Sonar LE 21
Proteus VX Sound Banks, obtaining additional 5
Proteus X Composer Bank, location 31

R
Recording a MIDI Track
   Ableton Live 34
   Cubase LE 11
   Sonar LE 21
Recording Audio
   into Cubase LE 8
   into Sonar LE 19

S
Save Project, Sonar LE 20
Scene Launch Button 32
Sonar LE
   multitrack recording 19
   project window 19
Sound Banks, obtaining additional 5

T
Technical Support Links 37
Track Record Enable Button, Sonar LE 20, 25
Tutorials
   Ableton Live 27
   Cakewalk Sonar LE 14
   Proteus VX with Ableton Live 30
   Proteus VX with Cubase LE 11
   Proteus VX with Sonar LE 21
   Steinberg Cubase LE 6

V
VST Connections, Cubase LE 8
VST Instrument
   Ableton Live 30
   Cubase LE 11
   Sonar LE 21